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Introduction Introduction
1 Introduction

1.1 Preface

Welcome to the HV/REx 500 User’s Manual. The HV/REx 500 software is intended 
for parameter setting and event handling, in MicroSCADA applications, of the corre-
sponding REx 500, RET 521 and RED 521 terminals, versions of these:

• REx 500 multi functional terminal 1)

• REL 501 line distance protection terminal 1)

• REL 511 line distance protection terminal 1)

• REL 521 line distance protection terminal 1)

• REL 531 line high speed distance protection terminal 1)

• REL 551 line differential protection terminal 1)

• REL 561 line differential and distance protection terminal 1)

• REB 551 breaker protection terminal 1)

• REC 561 control terminal 1)

• REO 517 line distance protection terminal (railway specific) 1)

• RET 521 transformer protection terminal 2)

• RED 521 busbar differential protection terminal 3)

See “MicroSCADA software available for REx 5xx” on page 12 for mapping of soft-
ware and terminal versions.

This is the User’s Manual for version 4.0 of the software module HV/REx 500. 

The HV/REx 500 software module is an add-on software to MicroLIBRARY which is 
used as a programming tool within MicroSCADA applications. The information pre-
sented on the MicroSCADA screen is similar to the presentation of the Station Moni-
toring System (SMS).

The HV/REx 500 software consists of three functional parts:

• Read terminal information

• Change terminal settings

• Handling of spontaneous events for presentation in lists.

To be able to understand this document the user should be familiar with MicroSCADA 
and MicroLIBRARY.

1)  REx 500
2)  RET 521
3)  RED 521
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This software module is developed and manufactured by ABB Automation 
Technologies AB, Västerås, Sweden.

1.2 Abbreviations and definitions

DDE Dynamic Data Exchange - Application Communication protocol

LIB500 Base library package

LIB520 High Voltage MicroLIBRARY

LON Local Operating Network

LAN Local Area Network

MicroLIBRARY Application library

MicroNET Frontend used in MicroSCADA (separate PC slot card)

MicroSCADA Family name of the control and supervision system used as 
HMI platform for HV/REx 500.

PCLTA PC slot card used for LON communication together with 
PCNET

PCNET Frontend used in MicroSCADA (communication software)

POT Process Object Tool

PST Parameter Setting Tool

SCT Standard Configuration Tool (Picture Editing)

SMS Substation Monitoring System

SPA ASCII communication protocol

SPANET SPA master based on MicroNET

SRIO SPA master

TCP/IP Transmission Control Protocol/Internet Protocol.
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1.3 System overview

The HV/REx 500 function is a part of the LIB520 in the MicroSCADA. In figure 1 the 
HV/REx 500 function is shown as a part of a system. The User´s Manual covers only 
the HV/REx 500 function.

Figure 1 HV/REx 500 system overview

The HV/REx 500 software is developed for direct LON and the two different SPA-
masters, SPANET and PCNET.

1.4 Product overview

The concept contains a full range of flexible and functional systems for monitoring, 
protection and control of all parts in the power system.

The terminals in the REx 5xx series consists of several numerical high-performance 
terminals for medium and high voltage applications. Almost all information and set-
tings available in the terminal can also be made available in a PC equipped with SMS 
programs. Since SMS also supports communication via telephone modems this makes 
SMS a way to travel to the station by wire, making physical presence in the station 
unnecessary.

N E T/LON

MicroSCADAScreen

Mouse

Keyboard

(Console)

2)

Communication protocols
1) LAN - TCP/IP
2) LON or/and SPA

X-terminal

1)

HV/REx 500
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1.5 Protection parameter setting

Protection parameter setting, is a mean for getting the same information on the 
MicroSCADA screen as on the built-in HMI (Human-Machine-Interface) on the front 
of the protection and control terminal. In this case, even more information is available 
through the MicroSCADA. This means that the HV/REx 500 program is a way to 
access information stored in the protection terminal, that is not available on the built-in 
HMI on the front of the terminal.

1.6 MicroSCADA software available for REx 5xx

The overview of available software versions for corresponding terminal versions can 
be found in “LIB520/580 Compatibility Overview”, 1MRK 511 124-REN.
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About the product

HV/REx 500 is a package included in the LIB 520 product for parameter setting and 
event handling of the corresponding terminal REx 5xx. The package is delivered on 2 
CD-ROMs, includes the software and the User’s Manual.

The software contains the module of HV/REx 500 which includes specific description 
files for communication with REx 5xx.

Please note that the HV/REx 500 can only be used to communicate with the corre-
sponding REx 5xx terminal. “MicroSCADA software available for REx 5xx” on 
page 12

Usage of this product in a MicroSCADA Hot standby configuration has a limited func-
tionality. The limitation is that the configuration data read from the protections and 
stored on disk is not included in the file shadowing which is transferring updated files 
to the standby PC in a normal operating system. These files are only copied when a 
MicroSCADA restart is made on the standby PC and the file dump from the hot PC to 
the standby PC is ready. How to install and set-up this product to work correctly in a 
Hot standby system configuration, See “Preparations to be made before installation of 
a library function” on page 23.

1 Preparations before software installation

1.1 System requirements

In order to operate, the software module HV/REx 500 poses the following require-
ments on its environment.

1.1.1 At the REx 5xx terminal end

Remote SPA-bus communication or LON-bus communication option installed in the 
terminal, which is used for process communication in HV/REx 500. The built-in con-
nectors for SPA or LON are used. Make sure that these are included when ordering the 
terminal.

1.1.2 The MicroSCADA PC

The following basic requirements on MicroSCADA PC:

• MicroSYS revision 8.4.4 or later

• LIB500 revision 4.0.4 or later

• Parameter Setting Tool (PST) v1.2 or later
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1.1.3 Installation

Installation of the HV/REx 500 and Parameter Setting Tool software contains two 
steps:

1 Installing the software:

• Installation of the HV/REx 500 software and Parameter Setting Tool software 
means running Lib 520 provided from CD-ROM and copying files from the CD-
ROM to the hard disk.

• Installation of the documentation and on-line help and the necessary applications to 
use these, are copied from the CD-ROM to the hard disk.

2 Installing the library function:

• Installation of the HV/REx 500 library function means copying the library function 
into a picture and create the necessary database.

�
Important note:
In order to avoid problems, it is strongly recommended not to have the MicroSCADA 
or any other application running during the installation.

For latest information about the HV/REx500 package, please refer to the release notes.
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2 Installation of HV/REx 500 packages

Before using HV/REx 500 and Parameter Setting Tool the software have to be 
installed on the hard disk of a MicroSCADA computer.

2.1 Installation of MicroSCADA software

�
Before installation of HV/REx 500 can take place, the user must make sure that the 
MicroSYS and LIB500 software is already installed on the PC.

2.2 Installation of HV/REx 5xx software

To install from the CD-ROM to the hard disk, please follow the steps below. The 
installation can at any time be terminated by clicking on the Exit button in the Installa-
tion dialogs.

1 Insert the Program CD-ROM in CD drive and start up the Windows Explorer.

2 Navigate to [drive:]\LIB_520. Double click on LIB520_XXX.EXE. In 
the appearing dialog, Click OK to continue the installation.

.

Figure 1 LIB 520 Software Installation - Welcome dialog
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3 Click the Next>> button to continue the installation.

Figure 2 LIB 520 Software Installation - System information 

This dialog has no information about earlier installed versions when the installation of 
LIB 520 is made for the first time.
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4 Select one more of the HV/REx 500 package by selecting the check boxes.

Figure 3 LIB 520 Software Installation - Package selection

If an earlier installation of LIB 520 has been made, package installation confirma-
tion can be avoided by selecting the check box “Automatically update all software 
packages without option to skip. There is also a possibility to jump back to the pre-
vious installation dialog by clicking “<<Back” button.

5 Change destination drive by clicking on Change Drive... (optional)

If the LIB 520 is installed for the first time default drive is C:. If an earlier installa-
tion has been made, the current target drive is default. Note that only the drive is 
selectable. The directory destination is fixed [drive:]\sc\lib4\....
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Figure 4 LIB 520 Software Installation - Destination drive selection

6 Click Start to execute the installation.

Figure 5 LIB 520 Software Installation - Installation progress

Now the files are copied to the selected destination drive.
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7 Read the message in the appearing dialog before clicking OK.

Figure 6 LIB 520 Software Installation - Parameter Setting Tool installation atten-
tion

After installation of the HV/REx 500 packages the Parameter Setting Tool HAVE TO 
be installed before any configuration of the installed terminal picture functions can 
take place. The configuration needs Parameter Setting Tool to create proper terminal 
instances.

8 Installation is now complete. Click OK.

Figure 7 LIB 520 Software Installation - Installation finalized

9 To read the ReadMe file, click Yes. Else No.

Figure 8 LIB 520 Software Installation - Open Read Me file

It is strongly recommended to read this file to be updated with the latest informa-
tion of packages included in the LIB 520 where HV/REx 500 is a part.
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2.2.1 LIB 520 Readme file

It is important to read and follow the instructions in the README.WRI file, which is 
installed to the directory

[drive]:\SC\LIB4\SMOD

Any specific release information, known errors and limitations are stated in this file. It 
is therefore very important to ALWAYS read the README.WRI file.

3 Installation of Parameter Setting Tool (PST) 
software

Please see PST Users Guide for installation instructions.

MicroSCADA Hot standby configuration
When MicroSCADA is configured for Hot Standby study that section in the PST User 
Guide thorougly to get the installation correctly and to avoid unnecessary problems.

4 HV/REx 500 documentation

The HV/REx 500 Users Guide (this document) is available in software form and can 
be found on the documentation CD. The document is in PDF-format, and Acrobat 
Reader is needed to view them. Acrobat Reader is a free downloadable PDF file 
viewer from Adobe Systems Incorporated.

If Acrobat Reader is not installed in computer, it can be downloaded from 
www.adobe.com. 
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5 Installing and configuring HV/REx500 function

5.1 Preparations to be made before installation of a library function

�
The following steps are essential when creating a new application and preparing it for 
use with HV/REx500 functions. Some are basic which should always be considered 
and carried out. Some are related to special system configurations which only have to 
be considered in those situations.

5.1.1 Consider and define the Authorization grouping.

The Authorization levels can be defined later. The setup is taken in account during 
standard function configuration. The Authorization grouping is defined in the User 
Management tool.

5.1.2 Setup the APL:BSV15 in SYS_BASCON.COM for OI attribute in Process data-
base.

See more See “Object identifier” on page 26

5.1.3 Define all stations with correct type (SPA, REX) in the base system before 
configuration of function.

This is needed to get the correct configuration. Since naming of command procedures 
and addressing of process objects (LON communication) is depending of type verifi-
cation against the base system configuration. To make the Event database creation as 
smooth has possible it is a good convenience step to take.

5.1.4 Activate the DDE server function in SYS_BASCON.COM

Set the SYS:BDE to 1 to activate DDE functionality in MicroSCADA. Parameter Set-
ting Tool and MicroSCADA uses this to communicate.

5.1.5 Define local printer for printouts in Parameter Setting Tool

See MicroSCADA documentation how to add a local printer to the MicroSCADA sys-
tem.

5.1.6 Additional configurations regarding LAN communication.

With LAN communication
To get PST working correctly it have to be prepared for working over LAN. Please see 
the PST documentation for this matter.

Without LAN communication
The start-up of the Parameter Setting Tool is dependent on how the MicroSCADA sys-
tem is configured. If no LAN is used, a stand alone PC, additional configuration must 
be made after installation of the LIB 5xx and Parameter Setting Tool software. Follow 
the instructions below to accomplish this:
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• Modify the PST_LAN_CFG.INI file
In the [drive]:\ac\apl\'apl_name'\par\apl directory open the 
PST_LAN_CFG.INI file with an editor e.g. Notepad.
Change the LAN INSTALLED from 1 to 0. Note No space allowed.

• Define startup Monitor shortcuts to start-up MicroSCADA monitors.
Define a short-cut to the monitor start-up program mons.exe. Right click on the 
desktop. In the appearing popup dialogs select New and Shortcut. In the appear-
ing dialog, click Browse. In the appearing dialog navigate to 
[drive]:\sc\prog\exec\mons.exe and click Open. Now the previous 
dialog text field in containing [drive]:\sc\prog\exec\mons.exe. 
Before clicking Next the text field contents some arguments must be added. Add 
at the end of the line so it will look like following:

[drive]:\sc\prog\exec\mons.exe -d your computer name 
1 -start_as_logon_user where your computer name is the name of the 
MicroSCADA computer.

Comments:

• This particular example expects that MicroSCADA service is up and running. 
Other arguments can be added to both startup the MicroSCADA service and open 
a monitor. The monitor definition can also be configured so that the size on the 
monitor can be modified. To go deeper regarding this see further MicroSCADA 
System Configuration manuals.

• The argument -start_as logon_user is the important part of the setup. It tells to 
MicroSCADA to use the logged on users context regarding authority and security 
within Windows.

• To use the MicroSCADA Monitor dialog so that the -start_as_logon_user argu-
ment is taken in account when creating a monitor see the MicroSCADA System 
documentation.

5.1.7 Hot standby configuration

When using PST in a Hot standby configuration 2 important preparations have to be 
made before installation of the HV/REx500 picture functions can be performed.
First installation of PST have to be made to fit the Hot standby configuration, See 
“Installation of Parameter Setting Tool (PST) software” on page 22 in this Users Man-
ual to perform this correctly.

During the configuration process of a HV/REx500 picture function, if the 
HOTSTANDBY_SYSTEM attribute is set and if the current system setup is for Hot-
standby, modification of the watchdog (WD) applications is made. Three command 
procedures will be created and modified to be able to handle the PST configuration 
data during the file shadowing. The PST_SWEEP:C and PST_UPDREG:C will be cre-
ated and the SHADUSR:C will be modified so that invocation of PST_UPDREG:C 
can be made.
24 1MRK 511 119-UEN *4p0rC



Installing and configuring HV/REx500 function Instructions
There are two “ifs” to be aware of regardless if the HOTSTANDBY_SYSTEM 
attribute is set or not. The 1st is if the current system is NOT Hotstandby then the cre-
ation nor the modification is performed. The 2nd is if the SHADUSR:C contains exe-
cutable code (not only comments) the modification of the current version of the 
SHADUSR:C is not performed. If any of these situations occur the updating of the 
watchdog application have to be made manually. The source code for this is found in 
[drive:]\sc\lib4\smod\relays\rexyxx\inst. 
Following files is for the different command procedures:

SRI_PST_UPDREG.CIN -> PST_UPDREG:C
SRI_PST_SWEEP.CIN -> PST_SWEEP:C
SRI_SHADUSR.CIN -> SHADUSR:C
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5.1.8 Object identifier

Before installation the use of the attribute OI (Object Identifier) must be decided. Start 
the MicroSCADA Control Panel. Select “Admin” and in the appearing dialog select 
“Config”. In the system configuration file SYS_BASCON.COM locate the following 
section:

;*******************************************************
;
; APPLICATIONS
;The usage of OI & OX -attributes (required by LIB 500)
@SV(15) = LIST(-

Process_Objects=LIST(-
OI=LIST(-

Title1=VECTOR("Station"),-
Title2=VECTOR("Bay"),-
Title3=VECTOR("Device"),-
Title4=VECTOR(""),-
Title5=VECTOR(""),-
Length1=10,-
Length2=15,-
Length3=5,-
Length4=0,-
Length5=0,-
Field1=VECTOR("STA"),-
Field2=VECTOR("BAY"),-
Field3=VECTOR("DEV"),-
Field4=VECTOR(""),-
Field5=VECTOR("")),-

OX=LIST(-
Title1=VECTOR("Object text"),-
Length1=30)))

The parameters Length1, Length2 and Length3 must now be set as follows: 

The Length1 is definition of the Station name (minimum length is 2), Length2 is the 
definition of Bay name (minimum length is 2) and Length3 is the definition of the 
Device (Object) name. The sum of these 3 values must be not exceed 63, however 30 
characters is recommended for e.g. Event- and Alarm lists and printer. For Length1 
and Length2 1 character is used for space (between Station name/Bay name and Bay 
name/ Device name).
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Two optional parts, Special_Identifier_1 and Special_Identifier_2 can be added to the 
above described Station-/Bay-/Device name. Still the maximum length is 30 charac-
ters. They can be used as additional identification of the objects and their signals. Lets 
assume that Special_Identifier 1, which is reflecting the Voltage level of a station, is 
added. The definition in the SYS_BASCON.COM shall look like this,

@SV(15) = LIST(-
Process_Objects=LIST(-

OI=LIST(-
Title1=VECTOR("Station"),-
Title2=VECTOR("Voltage Level"),-
Title3=VECTOR("Bay"),-
Title4=VECTOR("Device"),-
Title5=VECTOR(""),-
Length1=10,-
Length2=3,-
Length3=12,-
Length4=5,-
Length5=0,-
Field1=VECTOR("STA"),-
Field2=VECTOR(""),-
Field3=VECTOR("BAY"),-
Field4=VECTOR("DEV"),-
Field5=VECTOR("")),-

OX=LIST(-
Title1=VECTOR("Object text"),-
Length1=30)))

It is of great importance that this is made before configuration of the installed func-
tions because the configuration process takes these values in account when creating 
the process database. If variable @OI_LENGTH is not defined in the configuration file, 
then override value defined in standard function configuration file is valid, which 
means LENGTH1=2, LENGTH2=14 and LENGTH3=14. This may cause unex-
pected behavior in run-time, especially in the case where medium voltage and high 
voltage functions are installed in the same station picture.

For the event list, it can be configured if ‘Station_name’, ‘Bay_name’ and 
‘Device_name’ shall be shown (in the ‘Object-ID’ column of the event list). This is 
configured using the “Settings” tool (available under the ‘Options’ menu). Select 
‘Tools’ and ‘Show Object ID’. In the appearing dialog it is possible to configure if the 
‘Station_name’, ‘Bay_name’ and ‘Device_name’ shall be shown in the event list.

5.1.9 Timeout setup

The timeout for the two different SPA masters must be setup as follows:

• SPANET and PCNET

The line attribute Header Timeout (HT) shall be set to 2000 ms.
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5.2 Installation of HV/REx 500 library function

When the HV/REx 500 software is installed on the hard disk, it will be integrated in 
the MicroLIBRARY software structure. The next step is to install the library function 
in a process picture. To be able to understand the following description the user should 
be familiar with MicroSCADA and how to use MicroLIBRARY.

�
Note!
It is important to complete all steps in the order described below!

�
Note!
If a Hot standby system configuration is used then step 15 is very important to carry 
out.

1 Go to the Picture Editor.

Open the picture in which the installation of the HV/REx 500 library function shall 
be made. Minimum requirements for this picture is that the base function is 
installed.

Figure 9 Picture function installation dialog
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2 In the Installation tool, select LIB4, LIB 520, PROTECTION, PST_TERMINAL 
and the desired symbol size SMALL 1*1, MEDIUM 2*2 or LARGE 3*3 (which 
shall be highlighted).

Enter a name (‘Picture Function name’) for the function. ‘ID’ must be unique 
within the picture.

3 Select Install. 

The installed Picture function will be placed in the upper left corner area of the pic-
ture. Close the Installation tool.

4 By default the latest installed picture function is marked selected. Grab the 
picture function by click on it and hold the mouse button down and move the 
mouse to place in the picture were it shall finally be placed. Release the 
mouse button. 

5 Select the picture function configuration button for configuration. 

Figure 10 Standard Configuration Tool icon
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The Standard Configuration Tool (SCT) dialog will appear,

Figure 11 Standard Configuration Tool (SCT) dialog - Attribute view

6 Enter STATION_NAME. Maximum length see “Setup the APL:BSV15 in 
SYS_BASCON.COM for OI attribute in Process data-base.” on page 23. 
Default is ““.

This name is set as a part of the Object Indentifier (OI) attribute the Event database 
process objects.

7 Enter BAY_NAME. Maximum length see “Setup the APL:BSV15 in 
SYS_BASCON.COM for OI attribute in Process data-base.” on page 23. 
Default is ““.

This name is set as a part of the Object Indentifier (OI) attribute the Event database 
process objects.

8 Enter DEVICE_NAME. Maximum length see “Setup the APL:BSV15 in 
SYS_BASCON.COM for OI attribute in Process data-base.” on page 23. 
Default is ““.

This name is set as a part of the Object Indentifier (OI) attribute the Event database 
process objects.
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9 Enter SPECIAL_IDENTIFIER_1 and SPECIAL_IDENTIFIER_2 (optional parts). 
Maximum length see “Setup the APL:BSV15 in SYS_BASCON.COM for OI 
attribute in Process data-base.” on page 23. Default is ““.

This name is set as a part of the Object Indentifier (OI) attribute the Event database 
process objects.

10 Enter P_OBJECT_LN. Maximum 10 characters is allowed. Default is ““.

The logical name (LN) of the process objects.. 

11 Enter STATION_NUMBER. Range 0-5000 is allowed. Default is 0

The Unit number (UN) the process objects will get during event database creation.

12 Select TERMINAL_TYPE. REx500, RET521 or RED521. Default is None

The target terminal type which the function shall communicate with. This attribute 
is controlling and effecting the appearance of the COMMUNICATION, 
TERMINAL_VERSION, DATA_ACQUISITION_UNIT and 
EVENT_DB_TEMPLATE attributes. Note that the REx500 is common for several 
REx5xx terminal types e.g. REL561, REC561 and REL531.

13 Select COMMUNICATION. LON or SPA. Default is depending of the 
TERMINAL_TYPE attribute.

The type of communication between the terminal and MicroSCADA.

14 Select TERMINAL_VERSION. Default is depending of the TERMINAL_TYPE 
attribute.

The terminal version number. This number may be read on the built in HMI.

15 Enter DATA_ACQUISITION_UNIT. Free text of 10 characters. Default is a sug-
gestion depending of the TERMINAL_TYPE attribute. This may be manually 
changed.

This identifier is used to separate several configured devices of the same kind for 
the same bay object. If not any similarity is found “Not defined” is set instead. 
Identifier for SigTool Engineering Tool. This attribute is configured in two steps. 
First select the type in the list and secondly edit the selected type by alter the “?” to 
a number, e.g REC 561_2. “xx_?” or “xx_” is treated as REC 561_1 which means 
that if one unit is used the second step is not necessary. It is set as a part of the RX 
attribute for the process objects during Event database creation.

16 Select EVENT_DB_TEMPLATE. Default is depending of the TERMINAL_TYPE 
attribute.

This attribute is which database template the Event database shall be created from. 
A number of predefined templates are supplied with the HV/REx500 application 
package. These can be used “as is” or be modified via the “Event Database Tem-
plate Editor” found under the Tools folder of the SCT.
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17 Enter TERM_OBJECT_NAME. Maximum 50 characters, default is ““.

This is a freely selected text which is used for showing which terminal object is 
selected. This is shown in the Parameter Setting Tool menu bar. Note if this is left 
empty ““, a default string “UNKNOWN INSTANCE” is shown.

18 Enter LABEL. Maximum 20 characters, default is ““.

This is a freely chosen label, that will be shown in the process picture for this pic-
ture function. 

19 Select LABEL_POSITION. Choices are “ABOVE”, “BELOW“,”LEFT” and 
“RIGHT, default is “BELOW“.

20 Select AUTHORIZATION_GROUP from the list of alternatives.

The authorization groups are defined in the User Management Tool.

21 Select HOT STANDBY_SYSTEM if used

Select this checkbox if the system is a Hot standby system. This selection is impor-
tant for extracting configuration data from the registry, were PST instance informa-
tion is stored, to a file which is during the file transmission transferred to the 
standby PC. Registry on the standby PC is updated with the file content after com-
pleted transmission and the file is deleted.

22 Select USE_DIST_COLLECTOR if used

Select this checkbox if the system should use the HV/Collect for disturbance 
upload and handling.

23 Select VISIBLE, if the function should be visible or not. Choices are “TRUE” 
or “FALSE”, default is “TRUE”

If the function is accessible from the bay function, the VISIBLE button should be 
unset. Note If TERMINAL_TYPE is selected to RED521 then this attribute is NOT 
selectable. The reason for this is that RED521 has NO settings and therefor the 
appearance in the process picture is NOT applicable.

24 In the Standard Configuration Tool folders, select folder Tools and necessary 
tools for the desired action. Event Database Template Editor, Process Object 
Tool or Representation Tool in the list.

To created the Event database use the Process Object Tool. To modify the Event 
database template, use the Event Database Template Editor and finally to select 
another appearance of the push button in the process picture use the Representation 
Tool.
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Figure 12 Standard Configuration Tool

5.2.1 The Event Database Template Editor

The Event Database Template Editor is used for modifying the selected template, 
made by the setting of EVENT_DB_TEMPLATE attribute.

Figure 13 Event Database Template Editor
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5.2.1.1 Usage

When opening the editor the selected template of the EVENT_DB_TEMPLATE 
attribute is shown. A template is a text file which contains information for the event 
objects that can be created for the selected Terminal Type. The information in the tem-
plate is to some extent editable. Some information, e.g. Nr, Index, Address, is for dis-
playing information about the particular signals which makes it easier for the choices 
to make.

Information which are editable by the user is,

• In Use, To be created or not

• Object Text, the OX attribute of the process object

• Signal Type, only Event or Event and Alarm

In the list presentation of the signals, selections is made, either one by one or several 
by dragging the mouse. The selected signals editable information appears in the Edit 
area of the editor.

Figure 14 Event Database Template Editor - Edit area

The editable signal information appears in the different fields of the Edit area and 
beneath each field there is a checkbox which is controlling if the contents of respective 
field shall be transferred back to the list if the Save button is clicked. These check-
boxes is preset to “Update” but can be changed before clicking OK.

�
If several signals are selected the appearance of the Edit area is different. The Object 
text may Not be edited and the checkboxes are Not set to “Update”

Modifications that has been made is Not stored in the template file until Save has been 
invoked. This is made via the File > Save in the menubar

Figure 15 Event Database Template Editor - Menu selection “Save”
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or the Save button in the toolbar 

Figure 16 Event Database Template Editor - Toolbar selection “Save”

or simply Ctrl + S on the keyboard.

The HV/REx500 package comes with a number of predefined templates which can be 
selected among. As soon as a file is modified and saved, either as the same file or with 
another file name, the file will be placed in the /SC/APL/’apl_name’/APLMOD4/
LANG’lang’ directory. Where apl_name is the application name and lang is the lan-
guage number (0 is factory default e.g. English). How to save the template file is 
decided during the saving process.

After saving the template the attribute EVENT_DB_TEMPLATE will immediately be 
updated with either the same template name and an incriminated version number or a 
new template name with version number 1.00.

File data is possible to see by selecting View > Show File Data in the menubar.

Figure 17 Event Database Template Editor - Menu selection “Show File Data”

Figure 18 Event Database Template Editor - Show File Data dialog
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Note that template file name and template name is NOT the same. Template name is a 
descriptive text stored in the template file and is displayed in the 
EVENT_DB_TEMPLATE attribute together with the version number.

The template should be edited before the process objects are created so the user have a 
chance to effect what to be created. If the Event Database Template Editor is not 
entered the current setup of the file is used.

5.2.1.2 Address Overlap Check

The editor is equipped with a possibility to check if the event objects marked as “in 
use” can be created without any problems regarding Address Overlapping.

Figure 19 Event Database Template Editor - Address Overlap Check

Address Overlapping is when a process object is being created or modified with the 
same value for the Unit Number (UN) and Object Address (OA) as for an already 
existing process object. The result is that the process object will not be created or mod-
ified. The Process Object Tool will show the following message:

Figure 20 Process Object Tool - Error message box “Address Overlap”

Note that it occurs ONLY when LON is selected as communication.
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5.2.2 The Process object Tool

This tool is used for creating the process objects for the Event database.

Figure 21 Process Object Tool

The Process Object Tool is a standard tool and included in the core MicroLIBRARY 
functionality.

5.2.3 The Representation Tool

The Representation Tool is for viewing and selecting the graphical representation of 
the push button appearing in the process picture.

Figure 22 Representation Tool

The Representation Tool is a standard tool and included in the core MicroLIBRARY 
functionality.
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5.3 General Bay connected Terminal function

Not supported in this version.

5.4 Modifying event database

Some signals in the HV/REx 500 modules are also included in HV/Control (Supervi-
sion function) package and the HV/Voltage Control package. To avoid collisions at 
configuration of the system when these packages are used together, the decision must 
be taken which of these packages shall handle these signals. If not, the address over-
lapping (error 2136) will occur. If HV/REx 500 exists alone then masking of these sig-
nals is not necessary.

To mask these signals use the Event Database Template Editor.

5.5 Address overlap with other HV functions

5.5.1 Specific for REx 500

HV/Control (Supervision) signals in HV/REx 500 are connected to its resp. EV-block 
according to Table 1, “HV/Control (supervision) signals in HV/REx 500.” on page 38. 
These signals must be masked not to be created in HV/REx 500 if HV/REx 500 is used 
together with HV/Control (Supervision function).

5.5.2 Specific for RET 521

HV/Voltage Control signals in HV/RET 521 are connected to its resp. EV-block 
according to Table 2, “HV/Voltage Control signals in HV/RET 521” on page 39. These 
signals must be masked not to be created in HV/RET 521 if HV/RET 521 is used 
together with HV/Voltage Control

Table 1: HV/Control (supervision) signals in HV/REx 500.

Signal PDB index Event block

Internal fail 177 EV12/1

Internal warning 178 EV12/2

Internal num fail 179 EV12/3

Internal num warn 180 EV12/4

A/D conv fail 181 EV12/5

IO board error 185 EV12/9
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HV/Control (Supervision) signals in HV/RET 521 are connected to its resp. EV-block 
according to Table 3, “HV/Control (supervision) signals in HV/RET521” on page 39. 
These signals must be masked not to be created in HV/RET 521 if HV/RET 521 is 
used together with HV/Control (Supervision).

Table 2: HV/Voltage Control signals in HV/RET 521

Signal PDB Index Event block

TC IN REMOTE MODE 161 EV11/1

TC IN STATION MODE 162 EV11/2

TC IN LOCAL MODE 163 EV11/3

TC IN LOCAL HMI 164 EV11/4

TC IN MANUAL MODE 165 EV11/5

TC IN AUTO MODE 166 EV11/6

TC IN AUTO MODE BLOCK 167 EV11/7

TC BLOCK ABNORMAL U 168 EV11/8

TC HUNTING 169 EV11/9

TC LOW POSITION 170 EV11/10

TC HIGH POSITION 171 EV11/11

TC ERROR 172 EV11/12

TC RAISE SIGN 173 EV11/13

TC LOWER SIGN 174 EV11/14

Table 3: HV/Control (supervision) signals in HV/RET521

Signal PDB Index Event block

INTERNAL FAIL 145 EV10/1

INTERNAL WARNING 146 EV10/2

INTERNAL NUM FAIL 147 EV10/3

INTERNAL NUM WARN 148 EV10/4

REAL T CLOCK ERR 149 EV10/5
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�
As help during Event database creation to avoid Address Overlapping, the Event 
Database Template Editor provides a function (Check For Address Collision) which 
can be used to see if the selected to be created may get an already occupied address. If 
so actions can be taken before the objects are created. See further “Address Overlap 
Check” on page 36

5.6 Change of password

The REx 5xx terminal has no password handling of its own. Instead, remote setting 
activities are depending on the users authority level in the MicroSCADA. All users 
with authority level 2 or higher have access to remote setting activities.

New MicroSCADA users can only be added by the MicroSCADA system manager.

6 Trouble shooting

In this section the help can be found when errors occur.

6.1 Diagnosing errors

When errors occur, which they do tend to happen, the system produces error messages 
differently in MicroSCADA and in the Parameter Setting Tool. In MicroSCADA mes-
sages are either shown in popup dialogs or with yellow text in on the status bar at the 
bottom of the MicroSCADA window. In the Parameter Setting Tool errors are only 
shown in popup dialogs.

TIME SYNC ERR 150 EV10/6

TEST MODE ACTIVE 151 EV10/7

AIM BOARD 1 ERROR 152 EV10/8

AIM BOARD 2 ERROR 153 EV10/9

MIM BOARD ERROR 154 EV10/10

IO BOARD 1 ERROR 155 EV10/11

IO BOARD 2 ERROR 156 EV10/12

IO BOARD 3 ERROR 157 EV10/13

IO BOARD 4ERROR 158 EV10/14

DISTURB MEM>80% 160 EV10/16

Table 3: HV/Control (supervision) signals in HV/RET521

Signal PDB Index Event block
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6.1.1 MicroSCADA errors

Errors can occur at two situations, when configuration the picture functions and during 
runtime. Errors can be categorized in two groups, controlled and uncontrolled. The 
controlled errors are shown in a popup dialogs. Typical controlled errors are, configu-
ration incompatibility and Parameter Setting Tool is not installed. Uncontrolled error 
messages are composed of one or two status codes, and with or without a SCIL state-
ment or expression. These messages are shown on the status bar at the bottom of the 
MicroSCADA screen. Uncontrolled errors are programming errors (bugs).

Figure 23 MicroSCADA Error Message - Controlled Error

Figure 24 MicroSCADA Error Message - Uncontrolled error
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Errors shown this way are very serious which means that they should be reported to 
ABB representative as soon as possible.

The meaning of these codes are described in MicroSCADA document, Status Codes, 
1MRS751850-MEN.

6.1.2 Unlock terminal function

There is a hidden “escape” door when it is not possible to open the Parameter Setting 
Tool, even when it is not opened on any other monitor. A hidden push button is located 
up in the right corner, below the dialog bar

Figure 25 HV/REx 500 Information dialog - Emergency escape door button

Click one or several times on that position and a timer is started in the dialog. After the 
time expires the dialog will get a new appearance.

Figure 26 HV/REx 500 Information dialog - Emergency escape door

Click on the padlock push button and the former selection is released and opening the 
Parameter Setting Tool is now possible.

Hidden push button
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6.1.3 Parameter Setting Tool errors

Like MicroSCADA errors these errors can occur both when configuring the picture 
functions and during runtime. Errors generated when running to the Parameter Setting 
Tool are shown in dialogs.

See the Parameter Setting Tool User’s Manual for Error explanation.

6.2 Terminal busy

During communication with the terminal it sometimes happens that the terminal gets 
busy. This is a normal behavior and it occurs when the terminal has to much to handle 
e.g when SMS and MicroSCADA is reading from the same terminal at the same time. 
In these situations the program does not resend the message automatically. Instead the 
user can decide whether to continue, wait or to cancel.

Figure 27 Terminal busy

A probable cause for terminal busy can be:

• The terminal is occupied with storing e.g Disturbance data

• If the both communication ports are connected on the terminal and reading and 
writing is performed at the same time.
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Customer feedback report
Product:

ABB Automation Technologies AB would appreciate your comments on this product. 
Please grade the following questions by selecting one alternative per category. Your 
answer will enables us to improve our products.

How do you grade the quality of the product?

Excellent Poor

Total impression

Useability

Functionality

Human-machine interface

Comments: __________________________________________________________

____________________________________________________________________

____________________________________________________________________

How do you grade the quality of the documentation?

Excellent Poor

Total impression

Layout

Illustrations

Readability

Easy to find 

Content structure

Comments: __________________________________________________________

____________________________________________________________________

____________________________________________________________________
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Suggestions for improvments:

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Please send this report to:

ABB Automation Technologies AB
Substation Automation Products
Support Line
SE-721 59 Västerås
Sweden

By facsimile:

Send to + 46 (0) 21 14 69 18



Program:

This card registers your program and makes you eligible to receive information about 
future updates.

Name:

_____________________________________________________________________________________
Title:

____________________________________________________________________________________
Company: Dept.

____________________________________________________________________________________
Address:

____________________________________________________________________________________

____________________________________________________________________________________
City: State: Zip:

____________________________________________________________________________________
Phone:

____________________________________________________________________________________
Fax:

____________________________________________________________________________________

Program supplied by:

____________________________________________________________________________________
Adress:

____________________________________________________________________________________

____________________________________________________________________________________
City: State: Zip:

____________________________________________________________________________________
Phone:

____________________________________________________________________________________
Date of receival of the program:

____________________________________________________________________________________
Program serial Nr:

____________________________________________________________________________________

Fax:

Please send this registration card to ABB Automation Technologies AB, Substation Automation Products, 
Support Line (+46 21 14 69 18)

Software Registration Form
R

em
ov

e 
fr

om
 b

in
de

r



Place 
 Postage
Stamp 
Here

ABB Automation Technologies AB
Substation Automation Products
Support Line
SE-721 59 Västerås
Sweden

To be folded

Tape here

R
em

ov
e 

fr
om

 b
in

de
r



SOFTWARE LICENSE

• This ABB Automation Technologies AB License Agreement (”License”) grants you the nonexclusive right to use 
one copy of the enclosed software program (”SOFTWARE”) on a single computer (i.e., with a single CPU) at 
a single location at any time. If you have multiple Licenses for the SOFTWARE you may have as many copies
of the SOFTWARE in use as you have Licenses.

• The software is owned by ABB AB or its suppliers and is protected by Swedish 
copyright laws, international treaty provisions, and all other applicable national laws. Therefore you must treat 
theSOFTWARE as any other copyrighted material (e.g., a book or musical recording) except that if the 
software is not copy protected you may either (a) make a copy of the SOFTWARE solely for backup or archival
purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for
backup or archival purposes. You may not copy the Documentation accompanying the SOFTWARE.

• The License is effective until terminated. This License will terminate automatically without notice from
ABB AB if you fail to comply with any provision of this License. Upon termination you
shall return the diskettes containing the SOFTWARE and all Documentation to ABB AB 
and destroy any copies of the SOFTWARE or any portions of it which has not been returned to ABB 

AB, including copies resident in computer memory.

• You may not rent, lease, lend, sell or give away the SOFTWARE, but you may transfer your rights under
this ABB AB License Agreement on a permanent basis provided you transfer all copies 
of the SOF TWARE and all written materials, and the recipient agrees to the terms of this Agreement. You
may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based
on the SOFTWARE. You may not modify, adapt, translate or create derivative works based on the written
materials.

LIMITED WARRANTY

• ABB AB’s entire liability and your exclusive remedy shall be, at ABB 
AB’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that 

does not meet ABB AB’s Limited Warranty and which is returned to ABB 
AB with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has 

resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the 
remainder of the original warranty period or 30 days, whichever is longer.

• ABB AB disclaims all other warranties, either express or implied, including but not 
limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the 
WARE, accompanying Product Manual(s) and written materials. This warranty gives you specific legal rights.

• Neither ABB AB nor anyone else who has been involved in the creation, production or
delivery of this product shall be liable for any direct, indirect, consequential or incidental damages (including
damages for loss of business profits, business interruption, loss of business information, and the like) arising
out of the use or inability to use such product even if ABB AB has been advised of the
possibility of such damages. In any case, ABB AB's entire liability under any provision 
of this agreement shall be limited to the amount actually paid by you for the software.

ACKNOWLEDGEMENT

By opening the diskette package you acknowledge that you have read this agreement, understand it, and agree
to be bound by its terms and conditions. You also agree that it is the complete and exclusive statement of the
agreement between the parties and supersedes all proposals or prior agreement, oral or written, and any other
communications between the parties relating to the subject matter of the licence or limited warranty.

This Agreement is governed in all aspects by Swedish law. If any provisions of this Agreement are invalid or
unenforceable, all others will remain in effect.

IMPORTANT - READ CAREFULLY BEFORE OPENING

ABB Automation Technologies AB 

1. Grant of License

2. Copyright

3. Term

4. Other Restrictions

Limited Warranty

Customer Remedies

No Other Warranties

No Liability for
Consequential  Damages

This legal document is an agreement between You, the user, and ABB Automation Technologies AB, Västerås, SWEDEN. By 
opening the diskette package You indicate your acceptance of the terms and conditions of this agreement. If You do not agree 
to the terms of this agreement, promptly return the unopened diskette package and other items which are part of the product for a full
refund. Your product is a single user version unless you have a written agreement with ABB AB.

License Agreement

• ABB Automation Technologies AB warrants that the software will perform substantially in accordance with the 
accompanying Product Manual(s) for a period of 1 year from the date of delivery from ABB Automation Technologies 
AB, Västerås. ABB Automation Technologies AB does not warrant that the SOFTWARE is free from coding errors.
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Automation Technologies 
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Automation Technologies 
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ABB Automation Technologies AB
Substation Automation Products
SE-721 59 Västerås
Sweden
Telephone: +46 (0) 21 34 20 00
Facsimile: +46 (0) 21 14 69 18
Internet: www.abb.com/substationautomation
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